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From The Chief Editor's Desk
Every now and again, you just have to question what people are thinking. Let me show you a couple of examples. I've taken screenshots of some offending "designs" that have come across in my email, and they aren't even the worst offenders.
WHO thought it was a good "design" to make the text on web pages the lightest gray possible on a white background? In the post game box score of the first image, that is about as light of a gray text on a white background as anyone should go ... and that shade of gray text on a white background is difficult enough to read. But no, some of these ijits had to have an even lighter gray text on a white background (second image). It's so light that unless you're looking for it, you hardly notice there's any text at all below the headline.
Let's put it to you another way: how would you like for the text of this magazine to appear the same way, light, light gray text on a white background? In case you missed that, here it says again, but readable and without the "artistic" element of light gray text on a white background: how would you like for the text of this magazine to appear the same way, light, light gray text on a white background?
In my humble opinion, it's next to unreadable. That is, unless you highlight the text, as if you're selecting it to be pasted to your computer's clipboard. Maybe I'm getting old and my eyesight isn't what it used to be. Nah, that can't be it. That statement is only half true. I *am* getting older, but I had the Lasik procedure about 20 years ago, and I still have 20/20 vision. More likely than not, I grew up in a time when if you had something to say, you said it boldly. It's almost as if they are afraid to say what they have to say, as if they are trying to whisper. That doesn't mean that you type in boldface (which is equally as annoying), or in all caps (Heaven forbid!).
Reading text on a webpage shouldn't cause you more eyestrain and headache than staring at a computer display already does. There's absolutely no reason to make readers squint at the text of a webpage as if they're trying to figure out the grand cosmic meaning of ancient Egyptian hieroglyphics, or as if someone is trying to read an ancient Babylonian text. Readers shouldn't have to feel as if they are going blind when they read the text on your page.
Putting light, light gray text on a white background makes about as much sense as putting dark, dark gray text on a black background. And no, I'm not advocating the latter, either. Both are incredibly DUMB ideas. What is wrong with using just plain black text on a plain white background? Or, if that isn't your style, then can't you at least provide a reasonable amount of contrast between the background and the text so that the text can be read without squinting and unnecessary eyestrain?
It is true that many have called this the "Information Age." So provide us the information you want to share or disseminate, without causing more undue and unnecessary stress with your color choices.
********
This month's cover, designed by Meemaw, pays homage to the Mexican holiday of Cinco de Mayo. Contrary to popular belief (misconception), Cinco de Mayo isn't a celebration of Mexican independence. Mexican Independence Day is actually on September 16. Cinco de Mayo is a celebration of a poorly equipped Mexican army of 2,000 men defeating a superior force of 8,000 men from France's Napoleon III in May, 1862 at Puebla de Los Angeles when the French arrived to collect on a debt owed to them by Mexico.
Within Mexico, Cinco de Mayo is primarily observed in the state of Puebla, although celebrations occur across the country. In the United States, Cinco de Mayo is largely observed to celebrate Mexican culture and heritage, especially in areas with large Mexican-American populations. In the U.S., the celebrations include parades, parties, mariachi bands, Mexican folk dancing, and plenty of Mexican foods, like tacos and mole poblano. Oh, and lots and lots of beer. If you want to learn more about Cinco de Mayo, you can check here, here or here. These should get you started, as there are many other resources available for inquisitive minds.
So, until next month, I bid you peace, happiness, serenity and prosperity.
Short Topix: The 411 On 1.1.1.1 DNS Service
by Paul Arnote (parnote)
Google Shutters Short Link Service
Google is shutting down the short link service that it launched in 2009, named goo.gl. They cited a proliferation of other short link services, such as ow.ly and bitly. They also cited "changes in the way people find content on the web" (whatever that means).
The service is being shut down in three stages. First, after April 13, anonymous users and users who've never used the service before will not be able to use the service. Developers will only be able to use the service if they work on a project that has accessed the service before May 30. The goo.gl management console will continue to work until March 30, 2019. After that date, all short links previously made with goo.gl will continue to redirect to the intended web page.
Google has a long, long, long history of shutting down popular services ... or retiring them ... or abandoning them ... or pulling the plug before they've ever caught on. In fact, the list of services that Google has shut down is way longer than the services they offer. So no one should be surprised by this move.
So, that leaves the question of what other short link services remain? Let's take a look at a list, excerpted from The Intelligent Economist.
ow.ly - Previously free for use by everyone and anyone, use of this short link service now requires signing up for a free Hootsuite Dashboard account. So, it's still free, but it just requires signing up for a free account.
bitly - Bitly offers a free version of their URL shortening service. No signup necessary, but creating an account allows you to manage links quickly and change the URL from http://bit.ly/Jhc38q to http://bit.ly/Intelligent. You can only use keywords that other people have not taken, though.
TinyURL - TinyURL is a simple shortener that requires no sign-up and allows users to customize the keyword. The service is free to use, but there are no analytics.
Tiny.cc - Tiny.cc is a popular and free service that can log basic statistics for each short URL. Tiny.cc also allows you to create a custom URL.
is.gd - A simple and very short URL is.gd also allows you to customize your short URL. No sign up required. You can log statistics from their links.
soo.gd - soo.gd is a free and easy to use link shortener that allows you to customize the suffix of the URL. However, there is no analytics. It also produces a QR code for your shortened link.
s2r.co - s2r.co is a service that offers no statistics and no customization. However, no sign up required.
These are only the free services. There are other short link services that require you to pay, and we have excluded them from the list here. It's doubtful that you'll be unable to find a short link service that accomplishes what you (or most users) need among the free services that are available.
So, Google's assessment that there is a proliferation of short link services is accurate. We've presented seven such free services here that should more than replace the role played by goo.gl.
The 411 On CloudFlare's 1.1.1.1 DNS Service
Like just about everyone else on the internet, I initially thought that the announcement of this new DNS (domain name server) routing service was an April Fool's joke. Yes, it was announced on April 1. Surely, this must be one of those April Fool's jokes. But no, it's real. And when you think about it, this new DNS routing service was announced on the most appropriate day imaginable: 4/1, since the DNS address is four ones -- 1.1.1.1.
CloudFlare, a cloud-based website acceleration service, working in cooperation with APNIC (Asia-Pacific Network Information Centre), announced the new (and free) DNS routing service, 1.1.1.1. It is a drop in replacement for services provided by ISPs, OpenDNS or Google, as well as free WiFi hotspot providers. In any of the alternatives listed, they could log your access history for targeting advertising, or sell it to third parties who'll do who-knows-what with it.
The DNS routing service runs atop CloudFlare's content delivery network, which is used by millions of websites to speed up loading times by caching content in multiple discrete locations around the world. As a result, Prospect One's DNSPerf benchmark ranks the query speed of 1.1.1.1 just a tad over 14ms. OpenDNS, ranking second, comes in at just over 20.6ms. Google came in third with its 8.8.8.8 DNS routing service, at just over 34.5ms response.
Setting it up in PCLinuxOS is very easy. Open the Network Settings dialog for the network device you want to modify. Scroll down in the settings dialog until you come to the "Get DNS servers from DHCP" setting. Uncheck the checkbox, and put 1.1.1.1 in the DNS server 1 field, and 1.0.0.1 in the DNS server 2 field. Then select OK to save your changes. Disconnect, then reconnect, your current network connection for the changes to take effect.
So, what's the advantage? Well, CloudFlare's DNS resolver is setup to be the most secure DNS server on the planet. Logs are kept for debugging and data analysis, but deleted within 24 hours. An outside auditing firm has even been hired to insure that CloudFlare complies with the "no user data logs" pledge. What data is collected -- albeit for less than 24 hours -- is stripped of any user identifiable information. Contrast this with your local ISP, who is seeking to monetize your DNS data, especially in the U.S. since the FTC nullified the Net Neutrality rules. This is especially true if you use any of the "big" carriers, such as AT&T, Comcast, Time Warner (I think they're calling themselves "Spectrum" this week), Verizon, Charter, and a whole host of other large carriers. Since the repeal of the Net Neutrality rules, they are now free to sell your collected data (and they have a literal ton of it) to the highest bidder, all in an effort to target ads to you.
Typically, your DNS data records EVERY SINGLE SITE you visit, regardless if the site is a secure site or not (secure sites typically have a green padlock on your address bar). This is especially true if you are using your ISP's DNS resolver, which is the case when you leave the "Get DNS servers from DHCP" option checked in your network configuration. When we uncheck that box and insert CloudFlare's DNS resolver, we prevent our ISP from collecting all of that DNS data on us. Your ISP *does* maintain DNS logs that go back who knows how far, while CloudFlare does not maintain logs.
CloudFlare has the 1.1.1.1 address on "loan" from APNIC, who manages allocation and registration of IP addresses for the Asia-Pacific region. Partnering together, APNIC will conduct a study of the DNS traffic in order to measure the efficacy of caching systems, and to study potential new mitigations against DNS-powered denial of service (DoS) attacks.
APNIC is also sensitive to the security needs of users. Here is an excerpt from their statement:
APNIC is acutely aware of the sensitivity of DNS query data. We are committed to treat all data with due care and attention to personal privacy and wish to minimise the potential problems of data leaks. We will be destroying all "raw" DNS data as soon as we have performed statistical analysis on the data flow. We will not be compiling any form of profiles of activity that could be used to identify individuals, and we will ensure that any retained processed data is sufficiently generic that it will not be susceptible to efforts to reconstruct individual profiles. Furthermore, the access to the primary data feed will be strictly limited to the researchers in APNIC Labs, and we will naturally abide by APNIC's non-disclosure policies.
The service is available to users of Windows, Linux, OS X, or iOS. At this time, Android devices require a static IP address in order to manually configure the DNS. You can read more about CloudFlare's new DNS service here.
IoT Invades The Loo!
I know I've told you previously how my mind reads IoT, by placing a "di" after the first "I" in the acronym. Well, now there's one less place you can go to get away from these pervasive "connected" devices. Yes, that's right. They've even started invading public restrooms.
Someone obviously saw a problem and thought that IoT was the way to solve it. I'd have never seen this problem, since I don't fly (I have and don't mind it, but am vehemently opposed to the groping that's necessary to board a flight). And, since I don't fly, I never go to airports.
But, it seems that lots of people who do fly tend to avoid using the bathrooms aboard planes that are crammed into half the space of a small closet. That means when a plane lands, the first destination for the travelers after deboarding a flight are the airport's public restrooms. This can create lines -- sometimes long lines -- at the restrooms as travelers queue up to relieve themselves.
Now, a company calling itself "Tooshlights" has attempted to improve the situation by developing a traffic management solution for restrooms. A red light appears over a stall when it is occupied and in use, a green light appears over a stall when it is available, and a blue light appears when a handicap stall is available. The light changes color when the latch on the stall door is locked or unlocked. The latch wirelessly communicates with the overhead light to change colors based on the availability of the corresponding stall.
Women, when they go to a public restroom, tend to view a closed stall door as proof that it is occupied and unavailable. This can cause some unused stalls to go unused in times of need. Men, on the other hand, tend to casually look under the stall doors and between the cracks of the door, while gently pushing on the door, to see if a stall is occupied. But, since men are the worse about locking the stall door, pushing on the stall door can lead to some rather embarrassing encounters. It is hoped that the feedback of the lights changing colors will help remind men to use the stall latches.
Expect to see these "improvements" at LAX, in the American Airlines Terminal 4, and in United Airlines Terminal 7, before expanding throughout the entire airport. It is also expected to be installed in the busiest airport in the world, the Hartsfield-Jackson Atlanta International Airport very soon.
Of a positive note, the data collected (yes, they are collecting data from these devices) is used to help keep the restrooms cleaner by monitoring how busy the restrooms are and when they are the busiest. On the negative side, I only wonder how long it will be before these devices (and its data) are used for more nefarious uses, or how long it will be before some perv links the signal from the latches to trigger hidden cameras in the ceiling.
Over 20,000,000 Chrome Users Victims Of Fake Ad Blockers
If you, or anyone you know, have installed one of the following ad blockers in Google Chrome, you should immediately remove them from your system, according to Andrey Meshkov, co-founder and team lead of Adguard:
This was reported on the Adguard blog, on April 17, 2018. Growing ever popular among crooks, the taking of honest ad blockers, inserting malicious code, and re-releasing them under slightly different names has grown considerably during recent times. As you can see from the names of the fake ad blockers listed, the names are believable and seem innocent.
Certainly, no one (except the advertisers and those collecting money from the display of ads) wants to see any ads as they travel around the interweb. So, casual users who may not know or realize the difference between bonafide ad blockers and the imposters are most at risk.
According to the blog entry, this is how one such imposter works. First, It hides malicious code inside a well-known javascript library (jQuery). Then, this code sends back to their server information about some of the websites you visit. It then receives commands from the command center remote server. In order to avoid detection, these commands are hidden inside a harmless-looking image. These commands are scripts which are then executed in the privileged context (extension's "background page") and can change your browser behavior in any way. Basically, this is a botnet composed of browsers infected with the fake adblock extensions. The browser will do whatever the command center server owner orders it to do.
Meshkov goes on to blame the lax moderation of Google Play Store apps for their proliferation. Since the discovery of these fake ad blockers, they have all been reported to Google, and all have subsequently been removed from the Google Play Store.
An Ass-tonishing Solution
From the "you can't make this sh ... er, stuff ... up" department, researchers think they may have found a solution to two problems facing humans on long space flights, like to Mars and beyond. Those two problems are transporting materials and dealing with the solid waste produced by humans in space.
A team of researchers from the University of Calgary have devised a process called "Astroplastic." It produces PHB (polyhydroxybutyrate), a plastic, from solid astronaut waste (poo). That plastic can then be used to make 3D printed objects for use by the astronauts.
The process takes genetically modified E. coli bacteria to make PHB plastic granules. The process uses an ongoing fermentation and extraction process to create a continual PHB supply, suitable for use by a 3D printer aboard the spacecraft.
The astronauts' fecal matter, extracted from the vacuum toilet, is left to ferment for three days, where the volatile fatty acids (VFAs) are allowed to increase. It is those VFAs that they E. coli bacteria will chow down on, producing the PHB plastic. You can read the full PDF report on the process here (PDF).
While the original plan is to use it to make tools, like ratcheting wrenches, for the astronauts to use to make necessary in-flight repairs, let's hope that they don't use this poo-plastic to make eating utensils and toothbrushes.
New Cryptomining Malware Doesn't Need An Active Browser Session
Reported in an April 2018 press release from Check Point Software Solutions, Ltd.:
Check Point® Software Technologies Ltd. (NASDAQ: CHKP), a leading provider of cyber-security solutions globally, has published its latest Global Threat Index for the month of March, revealing a surge of cryptomining malware attacks -- specifically, an endpoint cryptomining malware known as the XMRig variant.
First seen in the wild in May 2017, XMRig entered Check Point's top ten most wanted malware index (8th) for the first time during March 2018, after a 70% increase in global impact. By working on the end point device rather than the web browser itself, XMRig is able to mine the Monero cryptocurrency without needing an active web browser session on the victim's computer.
"Cryptomining malware has been quite the success story for cybercriminals, and XMRig's rise indicates that they are actively invested in modifying and improving their methods in order to stay ahead of the curve," said Maya Horowitz, Threat Intelligence Group Manager at Check Point. "Besides slowing down PCs and servers, cryptomining malware can spread laterally once inside the network, posing a major security threat to its victims. It is therefore critical that enterprises employ a multi-layered cybersecurity strategy that protects against both established malware families and brand new threats."
In March, Coinhive retained its most wanted spot for the fourth consecutive month impacting 18% of organizations, followed by the Rig EK Exploit Kit in second (17%) while the Cryptoloot miner was third (impacting 15%). XMRig was the 8th most common malware variant, impacting 5% of organizations.
What makes this unique is that previous cryptomining malware exploits required an open browser session to perform its deeds. This exploit eliminates that "need."
XMRig, by itself, is not malware. It is commonly used to mine for Monero cryptocurrency. But the version now being seen has been "weaponized" to mine for cryptocurrency without requiring an active and open browser session.
According to a TechRepublic article, "It appears to be spreading via file sharing websites like DropMeFiles, 4Sync, and Rapid Files, which all feature public linking to downloads. Palo Alto Networks also reported instances of internet users being infected by malicious Adfly advertisements as well.
"Once installed, the XMRig malware uses proxies to hide its traffic and obscure the wallet destinations, and it also adds the infected PC to Nicehash, an online marketplace where users can sell their processing power for use by cryptocurrency miners."
Private Internet Access To Open Source Client Code
Over the next six months, Private Internet Access will release all of the code for its VPN client to the open source community. The first piece of code has already been released on GitHub for Java tinkerers to start working with. That first code piece is PIA's Chrome extension.
Even as a paying customer, I didn't know that PIA had a Chrome extension. But then again, I'm also not fond of Chrome, either. So, it makes sense that I wouldn't have known about the Chrome extension. Plus, the Chrome extension only protects your data in the browser, and has no effect on other programs that may running and connected to the web, so it's of limited value anyways.
Here is their announcement from their blog page, dated March 15, 2018:
Today marks the start of an exciting shift over here at Private Internet Access. As long-time supporters of the Free and Open Source Software community, we have started the process of open sourcing our software, and over the next six months we will be releasing the source code for all our client-side applications, as well as libraries and extensions.
We are extremely grateful to the Free and Open Source Software community for creating the foundations of the Internet as we know it. And while we may be late to the party, we are looking forward to furthering our work with a movement that aligns with our own passions, on both a personal and professional level.
We believe that the shift to open source is the right move for a privacy-focused business, and recognise that code transparency is key. We appreciate that our code may not be perfect, and we hope that the wider FOSS community will get involved, provide feedback, feature requests, bug fixes and generally help provide a greater service to the wider privacy movement.
Today, we are opening up the first of many repositories, the chrome extension, that allows users to access our network of proxies from their web browser. The chrome extension also boasts additional privacy and security features such as disabling the microphone and camera, blocking flash and ip discovery through WebRTC, and can also automatically block ads and tracking through PIA MACE™. Please note that the extension will protect traffic from the browser only and will NOT offer any protection when using other applications.
"Let's continue to fight the good fight. Freedom is an earned right, and we must continue to re-earn it everyday. As the world continues to fight, Private Internet Access will be there. In crypto we trust." -- Andrew Lee, Private Internet Access Founder, and long-term FOSS contributor.
Head over to GitHub, check out the repo and get involved! You can find us in #privateinternetaccess on chat.freenode.net if you have questions, comments or simply want to find out more about what we are up to.
Our longer term goal is to release all our code into the open, and we hope that you will join us on our journey. We have some exciting things planned, and would love to hear from you if you want to get involved ... and don't forget to keep an eye on our blog and/or social media as we will be throwing some exciting launch events further down the line.
It should come as no surprise that we think that open source is awesome, and as long-term consumers of open source we are really happy to now be in a position where we can contribute back.
If you have any questions or comments, please do drop us a line to opensource@privateinternetaccess.com, we look forward to speaking with you and hope that our transparency will ensure that you have some peace of mind.
According to The Register, "There is no schedule for when the rest of the client-side software will be made available, although PIA is a user of the OpenVPN application and conducted an audit of that code last year."
As a paying customer, I have to admit that PIA's client software has been problematic, especially when it comes to updates. Not too long ago, I attempted to perform the recommended update, only to find that the "update" would not complete installation. So, at that point, I switched over to using PIA via openvpn. Having PIA's software not properly install was the best thing to ever happen for me (regarding using PIA), since it forced me to use their service with openvpn. The openvpn route is easier, faster, and a lot less resource and memory hungry than their client software.
Here's to hoping that the open-sourcing of PIA's client software will help improve that software. I also hope the it will allow inclusion of the PIA client software in the PCLinuxOS repository, for those who might be interested in using the service via their client software. As for me, I'll keep using the openvpn access that they provide.
PCLinuxOS Recipe Corner
BLT Pasta
INGREDIENTS:
3 1/2 cups chicken broth
8 oz uncooked penne pasta (2 1/3 cups)
1/4 teaspoon black pepper
2 tablespoons butter
1 bag (5 oz) fresh baby spinach
1 1/2 cups grape or cherry tomatoes, halved
1 package (12 oz) applewood smoked bacon, cooked and coarsely chopped
Shredded Parmesan cheese, chopped fresh chives or chopped fresh basil leaves, if desired
DIRECTIONS:
1. In 4-quart Dutch oven, heat chicken broth, pasta and black pepper to boiling over high heat. Reduce heat to medium; simmer uncovered 11 to 14 minutes, stirring occasionally, until pasta is al dente and most of liquid is absorbed.
2. Reduce heat to medium-low. Stir in butter until melted. Gradually add spinach, stirring constantly, until starting to wilt. Remove from heat; stir in tomatoes and bacon. Top with remaining ingredients.
Tips:
Cooking your bacon ahead of time will save on meal prep. Serve pasta with a side of warm and crusty buttered garlic bread.
Go Mobile on PCLinuxOS with a Verizon Wireless Ellipsis Jetpack
by phorneker
I had written two articles (one on DigiKam and the other on a new mouse I purchased) ahead of schedule, in case I become unable to get online as there are two issues I had to deal with.
The first is that my aging laptop. This is a Hewlett-Packard Compaq 8510p that is now ten years old, and has been known to overheat at times. Thankfully, I make it a point to myself to always back up data to physical medium, so that data will always be available in case I have to reinstall PCLinuxOS (be it on the same machine or another machine).
For the record, I do not trust commercially available cloud services such as iDrive for system backup. Suppose you relied on these services. It will give you some sense of security and safety for your data. But what if there is an Internet outage? Do not think that this could not happen. In 2014, there was such an outage in Laporte County, Indiana when NIPSCO accidentally cut a fiber optic cable while servicing one of their utility connections on US 20. This cut disrupted Internet service throughout the county, hence disrupted businesses throughout Michigan City and Laporte. If such an outage were to occur, you would have no access to your system backups. Having your laptop or desktop data stored on physical medium is the only way to be sure your data is safe and secure. |
The second issue I had was the DSL modem quit working after ten years. Replacing the DSL modem presented some real challenges. First, DSL modems are hard to find locally, thanks to the popularity of cable modems and mobile broadband. Second, the cost of DSL service had slowly gone up over the years.
At that point, I decided to change the way Internet access was done on PCLinuxOS. Instead of DSL, I would go mobile broadband the same way that I ditched the landline for a cellular phone.
As I was happy with the service I got from Verizon Wireless on my phone, I went with Verizon Wireless for an Internet provider.
In the early days of mobile broadband, running Linux used to present a number of challenges, not the least of which was getting the 3G and 4G broadband modems to work with Linux. With the availability of mobile hotspot devices and the growing smartphone and tablet market, Linux support is no longer an issue, so if you need to connect PCLinuxOS to a mobile broadband provider, devices like the one in this article are a good way to connect PCLinuxOS and take that connection with you. |
Verizon's newest mobile hotspot offering is the Ellipsis Jetpack MHS900L, and is a Franklin Wireless product. It is smaller than a typical smartphone in size and six of these (stacked in three rows of two each) will take up the space of the (now defunct) DSL modem.
This unit sells for $47.99 at Walmart. (It was $59.99 at Meijer, but I got a $40.00 Verizon Wireless prepaid refill card free with the purchase of this hotspot).
The box contained the hotspot, a battery, a USB charger, and the instruction manual.
Setting up the unit was easy. As the SIM card was already installed in the hotspot, it was essentially ready to go. All I did was insert the battery, close the bottom cover, and plug in the charger to the USB port.
On the front side in front of the Verizon logo, there is a button that powers the unit on and off. When lit red, the hotspot is charging. When green, the battery is fully charged. Pressing the button will give you information on the LCD display, namely the battery level, the number of messages stored on the hotspot, and the number of devices connected to the hotspot.
Once charged, the unit will need to be activated the first time it is used. This Jetpack can be activated from PCLinuxOS. When powered on for the first time, you will need to press the power button one time to get the ESSID (starting with Ellipsis Jetpack followed by a unique four digit hexadecimal number). Pressing the power button a second time will give you the password (also the WPA-PSK key for network configuration).
Be sure to record these data in the user manual as you will need these data to connect to the hotspot from Network Configuration in PCLinuxOS.
Once the hotspot is powered up, connect using Wi-Fi and open a web browser (use Chrome or Firefox for this) to http://my.jetpack to begin activation. If the activation page does not appear, you will need to enter https://verizonwireless.com/activate into the browser to begin activation.
The Jetpack will then connect to Verizon's 4G LTE network and you will need to register the device with the usual name, address, and e-mail address data. A My Verizon account will be created. You will need to select a wireless plan and provide credit card information for payment of monthly or bi-monthly service (depending on which plan you choose). The credit card information is needed to be entered once. Afterwards, you will have the option to add funds either from the Verizon website or through prepaid cards you can purchase most anywhere.
Once the payment is accepted, the Internet service will be activated and the Jetpack is ready to use.
Among data plans offered by Verizon are:
This is not the same as the $75.00 Unlimited plan offered for smartphones, which can be tethered to PCLinuxOS machines. For this, the smartphone has to be used as a mobile hotspot.
So what happens when you run out of data before the time period expires? On some hotspots such as the ones from Straight Talk, the service simply shuts down until the end of the time period, after which you will have to add funds from another connection for use with Straight Talk.
Here is where Verizon Wireless has a real advantage. When the LTE data allowance has been depleted, the Internet service slows down to about 128 kilobaud per second (the same as a DSL connection) for the remainder of the time period, giving you time to add funds to your Internet account before the period expires. Once funds are added, and a new time period begins, the hotspot goes back to 4G LTE speed.
Verizon Wireless considers PCLinuxOS machines the same as Android tablets when it comes to activation and administration of the Jetpack. |
Once activated, login to
http://my.jetpack or http://192.168.1.1 to administer the Jetpack. Sign in using the password (WPA-PSK key) you used to activate the Jetpack. (You can change the password within the Settings tab on this page.)
The default settings provided with the Jetpack are optimized for the best security available for wireless networking.
Be sure to keep track of data usage. This is the amount of 4G LTE data available in your monthly (or bi-monthly depending on the plan you choose).
Overall, this mobile hotspot performs in places where other routers fail due to the vast 4G LTE coverage Verizon provides (including most of the area that makes up the Rocky Mountains). You cannot get THAT with T-Mobile or Sprint (and its resellers such as Boost Mobile, which sells a 10GB pan for $50.00/month).
ms_meme's Nook: PCLOS Caravan
PCLinuxOS Family Member Spotlight: Onkelho
As told to YouCanToo
What is your name/username?
My name is Thomas Fröhlich, but on the forum I'm known as onkelho.
How old are you?
In near future I would count 50.
Are you married, single?
Luckily married to the most honest woman in the world.
How about Kids, Grandkids (names and ages)?
Of whom I know, there are two, but still no grandchildren. My first daughter studies science, history, philosophy, my second daughter is still attending grammar school, and my stepdaughter studies economics.
Do you have pets, what is your favorite?
I love animals and therefore leave them alone. Living in a city apartment, I would find it torment to live in a cage or on a leash. Maybe the animals are of the same opinion.
Are you retired, still working and if working, what do you do?
I could not find any better work than at one of the most beautiful theaters in the world, the Semperoper Dresden, my home and birthplace, theater craftsman, decorator. That's how multifaceted is my work.
Where do you call home? What is it like? IE: weather, scenery
See above, Saxon Switzerland is not far away and there are also trees, mountains, lakes and rivers. Some of them even with bridges.
Dresden on the banks of the Elbe River
Elbe sandstone mountains
Where did you go to school and what is your education level?
I am a trained machine and plant fitter for polygraphic printing machines. I studied at a navy officer college. I was young and wanted to become a naval officer, then came in 1989 and I at least had a college degree in math, physics and electrical engineering and PC users Basic knowledge ...(8bit - BASIC)
What kind of things you like doing? hobbies, travel, fishing, camping?
Unfortunately, the salary for civil servants in the state of Saxony is bad, so there is no money for hobbies and also the time, three-tier system and family is never easy. My last real holiday was in 2011 in the country of birth of my wife, Vietnam.
Why and when did you start using Linux?
Oh, I think this was in 2002, a release of Mandrake, then BeOS - the fastest system on all times, 2007 PCLinuxOS, not connection over ISDN in Germany - but Mandriva works, so I recompiled a PCLinuxOS kernel with the right settings, and then I connected to PCLinuxOS. I learned many things from SAM-Linux. At this point, "THANK YOU FOR SAM-Linux." This was my wake up for my love of Xfce.
What specific equipment do currently use with PCLOS?
Old school … Monitor, Keyboard, Mouse. My PC is 7 years old, AMD with a Gigabyte MB, GigaByte 870SB Phenom II X4 955, Asus EHA5770, 16GB RAM.
Do you feel that your use of Linux influences the reactions you receive from your computer peers or family? If so, how?
No.
What would you like to see happen within PCLOS that would make it a better place. What are your feelings?
Everything is fine here. I just wish I had more English skills, Texstar would have a $10 billion budget per month, and every person on earth would have a basic income of $ 2,000, no matter if politician or worker, farmer or industrialist, doctor or scientist, fixed rental prices of 1 Euro per square meter, no energy from coal, nuclear power or wood. Whoever drops a tree has to plant 3 new ones! Agra areas without monoculture, divided and surrounded by forest, plastic and electrical waste should be disposed of where it is produced. There are many things are not ready for survival yet.
PCLinuxOS Family Member Spotlight is an exclusive, monthly column by YouCanToo, featuring PCLinuxOS forum member. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.
If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.
Firefox Quantum: The Improvements Keep Coming
by Paul Arnote (parnote)
OK. I don't try to hide it. I'm a Firefox fan. Firefox has been my browser of choice since version 1.0. I started using it during my Windows days, before I found the enlightenment of Linux. In fact, it was the predominance of Firefox in the Linux community that helped ease my transition from Windows to Linux.
In November 2017, Firefox shook up the browser world -- and reignited the browser wars -- with the release of Firefox 57. We covered its grand unveiling in our January 2018 issue. Barely six weeks later, Firefox 58 was released, complete with the new Quantum rendering engine. The new rendering engine gave Firefox 58 yet another speed boost, making Firefox the fastest browser of all the major competitors. And it did so while consuming less memory and resources than all of its major competitors.
I had even given up on Firefox before the release of Firefox 57. It had become slow and clunky. I tried to stick with it for as long as I could, but found myself unable to do so any longer. I abhor Google Chrome, for many reasons. Like it always phoning home with your data at every opportunity. Like how much of a memory and resource hog it is. So I switched to Opera for a bit. Opera is a fine browser, without a doubt. But it just didn't feel like "home." So, I was quite happy when Firefox 57 came out. It regained use as my everyday, go to browser. I still keep Opera installed for those occasional cases when things still won't display just right in Firefox, but I find those cases are becoming more and more rare.
As anyone might expect, not everyone was happy about the changes that came with the newer and leaner Firefox. Particularly, the biggest change came when Firefox 57 dumped the familiar XUL and XPCOM based add-ons in favor of the more robust WebExtensions. But some add-on authors and programmers failed to make the transition to WebExtensions, and some users were left without the use of their favorite add-ons. As a result, many users chose to either stay with Firefox 56, or switch to Waterfox, a fork of Firefox that maintained support for the older XUL and XPCOM add-ons.
Since then, the Mozilla developers haven't rested on their laurels or their past accomplishments. They've kept rolling out improvements over the intervening months.
New Tab Customization
Above is a screen capture of the default settings for the new tab page. You have a search bar at the top. You then have six of your most visited sites listed, followed by recommendations from Pocket. At the bottom are Firefox snippets, which could include things of interest about Firefox, internet culture, quotes, or even memes. If you scroll down, you'll find the Highlights section. Recently visited pages will appear in this section, making it very easy to go back and reread (or finish reading) something you might have found interesting.
Next to each heading -- Top Sights, Recommended By Pocket, Highlights -- you will see a downward facing caret. Click on the caret and that corresponding section will collapse. Click on it again to expand the view again.
Placing your mouse cursor on the same line as each section heading will cause more options to appear at the upper right edge. Most sections will minimally have a question mark icon. Clicking on that will either give you options for that section of the page, or direct you to the overall settings. Some, like with the Top Sites section, will open a dialog window when you select "Edit" at the upper right (shown below).
You are given the option to add more sites to the Top Site section, or to show more. Clicking on the "Show More" button will expand the number of top sites shown to 12. The "Show More" button will then toggle to say "Show Fewer" if 12 top sites are shown. Click on the "Done" button to accept your changes.
Back in the main New Tab page, hover your mouse over the icons for the sites listed in the Top Sites section. A three-dot menu will appear at the upper right "icon" representing that page. Clicking on the three-dot menu will open a submenu that will allow you to edit the URL for that page, pin it to make it always appear, open it in a new window or a new private window, dismiss it from the list, or delete it from your history.
Take notice of the gear icon in the upper right corner of the main New Tab page. Clicking this icon will display the settings options for the New Tab page.
Simply check the options you desire, or clear the checkmark from the options you don't want to see. The choices are well explained and should be fairly obvious.
You can also show more than 12 site in the Top Sites section. In a new tab, enter about:config in the address bar. Accept the acknowledgement that you will be careful, and search for the browser.newtabpage.activity-stream.topSitesCount setting. If you want to see three rows of sites listed, enter 18 as the value. Similarly, if you want to see four rows of sites listed, enter 24 as the value. Since six sites are shown on each row, the number you enter should be a multiple of six.
Improved privacy in private browsing sessions
You're leaking data about your online activities all the time. For most people, they don't even realize it. If you're even a little bit security or privacy conscious, this new enhancement in Firefox 59 is for you.
A lot of sites "track" you by requesting a referrer value. This value sends the exact URL of the page you just came from to the new site. It creates a map, of sorts, that can point to other interests you may have so that data about your likes and dislikes can be sold to potential advertisers. In turn, the data is used to target advertising to your likes, in the hopes that the advertising will be more relevant to your interests, improving the chances that you will click on the ads and possibly buy something.
Facebook uses this method extensively. So does Google, Twitter, Yahoo, Doubleclick, Akamai, and a whole host of other companies. Some of these companies just resell your data. Others use this data, combined with literal tons of other data about you, to create an extremely detailed profile about who you are and what your interests are. Advertising revenues are the lifeblood of these companies. Without that advertising revenue, they would literally shut down overnight. The more relevancy their ads have, the greater the chance that you will click through the ad and possibly purchase something.
Pretty scary, huh? Well, don't worry. It gets worse.
Let's say you visited a Reddit thread on privacy, and then travelled over to the Mozilla Security blog site. Or, let's say you visited the website for The PCLinuxOS Magazine and read phorneker's article on the Logitech M325 mouse, before heading over to Facebook. In the first case, the Mozilla Security blog site will have received something like the following:
referrer:
https://www.reddit.com/r/privacy/comments/Preventing_data_leaks_by_stripping_path_information_in_HTTP_Referrers/
It would show (to those who collect your data) that you're interested in privacy issues. Before you know it, you might just start being bombarded with advertisements about privacy tools.
In the second case, Facebook would have received something like the following:
referrer:
https://pclosmag.com/html/Issues/201804/page10.html
Any page crawler, which is employed by many services, will know that the page is about the Logitech M325 mouse, simply based on the content there. Before long, don't be surprised if you start seeing a lot of ads for new mice and keyboards.
Both of these examples are innocuous enough, in and of themselves. But, let's take a look at another example that should scare the pants off anyone. Let's just say that you are a U.S. resident, and you just visited healthcare exchange on healthcare.gov.
referrer: https://www.healthcare.gov/see-plans/85601/results/?county=04019&age=40&smoker=1&pregnant=1&zip=85601&state=AZ&income=35000
This is exactly what EFF (Electronic Frontier Federation) discovered was transmitted to Doubleclick, a piranha that collects such data to serve up ads. In this referrer information, the users zip code, their age, whether they are a smoker or not, whether they are pregnant or not, their state of residence, AND their annual income are all exposed.
Wow! What a treasure trove of highly personal information! Most users have absolutely no idea that this information is being passed on, or even collected. As far as they are concerned, they are just browsing around the web, "feeling" as if their information is secure and feeling as if they have control over whom receives particular information. But, as it appears, that is anything but the case.
So what's a user to do? Well, thanks to the release of Firefox 59, the information after the website is stripped away in the referrer statement, if you use the private browsing option. So, in the case with the website for The PCLinuxOS Magazine, only the https://pclosmag.com will appear in the referrer statement. In the case of the Reddit example, only https://www.reddit.com will appear in the referrer statement. And, most importantly, in the case of the Healthcare Exchange website, only the https://www.healthcare.gov address will appear in the referrer statement. What's happening here should be obvious, as all the extra data but the website itself is stripped away from the referrer statement.
There are also some other security related settings in Firefox that pertain directly to the information provided by the referrer statement. You can find a list of them in the Mozilla Wiki. I am not sure if these setting apply only to private browsing, or if they apply across the board regardless of the browsing mode you're operating in. The information on the wiki isn't the easiest to dig out, and the wiki entry doesn't make it clear if it's for all browsing modes or just private browsing.
Website authors can also do their part in preventing this leaking of information. All they have to do is put "Referrer policy: no-referrer" into the header of their pages. But I wouldn't count on many to do so. There are a lot of websites that depend, either partially or wholly, on advertising revenues to generate a revenue stream. Preventing referrer data from being passed along appears to go counter to their own survival. If most websites did this, then the advertising revenues might be severely impacted. But never fear, I'm sure those who want to suck up your personal and private data will find other sneaky ways to do so.
Summary
The Firefox team at Mozilla certainly seems to have the end user in mind. From customizing your new tab page to protecting your private and personal information, they allow the end user to empower themselves. If you've never read the Mozilla Manifesto, you should take the time to do so.
We've said it before and we'll say it again: your personal and private data are the currency of the digital age. It probably has more worth than the most expensive cryptocurrency. Protecting that data is your responsibility, and one you should not take lightly. Do everything you can to protect your personal and private data.
ms_meme's Nook: Sheik of PCLOS
YouTuber - More Tips To Get There With PCLinuxOS
by Alessandro Ebersol (Agent Smith)
Continuing the series of articles on how to become a YouTuber, this month I will address a few necessary (and useful) programs, real tools to produce gameplays and make your videos. We will see two emulators, one the EP128 emulator, and the other, the classic MAME.
Ep128Emu
ep128emu is an open source, portable emulator of the Enterprise 128, ZX Spectrum 48/128, Amstrad CPC 464/664/6128 and Videoton TVC computers, written in C++, and supporting Windows and POSIX platforms (32 and 64 bit Windows and Linux, and MacOS X have been tested). And, it is an exclusive of PCLinuxOS. No other distro has it in their repos, since it was ported by our dear colleague MBantz.
It implements accurate, high quality hardware emulation. However, the system requirements are higher than that of most other emulators. It was written and is maintained by Istvan Varga.
Features
What matters is the video capture, and, according to its website data on Github, the Ep128Emu is able to "video recording and sound output in a video file in AVI format with video YV12 uncompressed 768x576 RLE8 or 384x288 at 24 to 60 frames per second, and 48000 Hz stereo PCM audio 16-bit.”
Main Screen
To do so, choose the resolution among the two available (768x576 or 384x288 RLE8) and, as shown below, start recording:’
The program will ask the filename and where it will be saved (the extension must be AVI), and start recording.
To stop, open the File menu, Record video and press Stop.
MAME
MAME means Multiple Arcade Machine Emulator. When used in conjunction with data files of a game (ROMs), MAME reproduces more or less faithfully, the game on a PC.
MAME can emulate over 8000 classic arcade games from the 70's, 80's, 90's and 2000's. The ROM images that MAME utilizes are "downloaded" ROM chips of the printed circuit boards of the games. MAME then becomes the hardware for the games, taking the place of their original CPUs and support chips. Therefore, these games are not simulations, but the real games that appeared in arcades.
The purpose of MAME is to preserve these early decades of the history of arcade games. While the game technology advances, MAME prevents these important "classic" games from being forgotten and lost.
And with MAME, it's extremely easy to record video gameplays. But some changes are needed.
Now, let's look at the process, step-by-step:
Search $ home/.mame/mame.ini (MAME configuration file). Open this file in your favorite plain text editor.
Look for this section:’
#
# CORE STATE / PLAYBACK OPTIONS
#
In this section, look for aviwrite, and set it to 1.
Now, to record a video of your gameplay, it is configured the key combo Left-Shift + F12. Press one time to start recording, and the second to stop recording. It will record your gameplay in an AVI file in the folder snap.
The produced AVIs are not compressed, huge, and slow to create. Therefore, there's the need of a video editor to do the post-production.
As an example, I made a recording (to write this article) of 34 minutes of gameplay. The resulting file was 32GB's large. Of course, I processed the file with Winff, and converted it to a 600MB MP4 file.
And so I end another article of tips to be a YouTuber. More next month. See you there!
GIMP Tutorial: Sphere Variations
by Meemaw
In the March issue, we created a spinning globe which had text or an image on it. This time we're going to use a different GIMP filter to create another globe, or sphere, with two different effects.
The first effect will be a "photo sphere." The first time I did this was with pictures of my grandchildren. This time I am using sections of my favorite wallpapers created by many of our PCLinuxOS family members. I edited sixteen images, all 450 x 450 px, set into an 1800 x 1800 px grid.
Create a new image, 1800 x 1800 px. Grab three guides from top and side and place them 450 px apart to make a grid. Copy and paste your images into your grid. It should look similar to the following;
Now, Click on Filters > Map > Map Object. The following window will appear. Choose Map to Sphere and check Transparent background, and Create new image (unless you want the sphere to appear over your grid).
Click on the Orientation tab and choose the following rotations:
The result:
You'll see different parts of the sphere if you change your rotation settings.
Our other variation is a spiral. Create a line of black stripes.
Select the black, then click Select > Grow and grow the selection by 15 px. Create a new layer and choose the Gradient tool, then fill the selection (in the new layer) with a brushed aluminum gradient. Then move it to the bottom and merge the layers. Click Colors > Color to Alpha and choose white. Choose a pattern to fill the black (I used a water pattern) and use Bucket fill.
Now choose the rotate tool, and rotate your stripes -10 degrees.
Crop it down so you have stripes clear to the edge all around.
Save your work.
Now click on Filters > Map > Map Object, and choose the same settings as before.
With a bit of planning, you can make the stripe continuous. If you don't rotate your stripes, it comes out nice anyway.
Let your mind wander. The possibilities are endless!
PCLinuxOS Bonus Recipe Corner
Shepherd's Pie Skillet
INGREDIENTS:
1 lb lean (at least 80%) ground beef.
1 Box Hamburger Helper™ Salisbury
(Hot water and milk called for on Hamburger Helper box)
1 1/2 cups frozen mixed vegetables, thawed.
Betty Crocker™ mashed potatoes for 6 servings.
Water, milk and butter called for on mashed potatoes box for 6 servings
1/4 cup shredded Cheddar cheese (1 oz)
Chopped fresh parsley
DIRECTIONS:
1. In 10-inch skillet, cook beef over medium-high heat 5 to 7 minutes, stirring frequently, until brown; drain. Stir in hot water, milk, sauce mix and uncooked pasta (from Hamburger Helper box) and thawed vegetables. Heat to boiling, stirring occasionally.
2. Reduce heat; cover and simmer about 10 minutes, stirring occasionally, until pasta and vegetables are tender. Remove from heat.
3. Meanwhile, make potatoes as directed on box for 6 servings. Spoon and gently spread mashed potatoes over pasta mixture. Sprinkle with cheese. Cover; let stand about 5 minutes or until cheese is melted. Sprinkle with parsley.
TIP:
Love garlic mashed potatoes? Stir in some finely chopped fresh garlic to your liking.
Repo Review - Day Planner
by CgBoy
A while back, I was looking for a simple program to remind me to practice playing the piano. I looked in the PCLinuxOS repository, and tried several event reminder programs until I found one called Day Planner, which was simple and easy to use.
On the left side of the program, you can see all the events for the currently selected day in the calendar at the top right. On the lower right, you can see all the events for the next seven days. It'll also show public holidays too. The buttons at the lower left of the program are for adding, editing, and deleting events.
There are three types of events that can be created, Normal, All day, and Birthday. Normal, as its name implies, is just a normal event, where you set the date, time, and description. You can have the event repeat every day, week, month, or year, until a certain date. All day is the same as Normal, except that you can't set an event time because the event lasts all day. Birthday just allows you to set the name and birth date of someone.
Reminders for the events can be set to start going off 1 day - 10 minutes before the event is due.
Day Planner comes with two plugins installed. One is for synchronizing with the Day Planner synchronization service, and the other puts a Day Planner applet into the system tray. When I tried the synchronization plugin, it complained about a missing Perl module. Maybe it works on other systems. I don't know. Day Planner can also export and import iCalendar .ics files.
Summary
If all you need is a simple event planner, this is a good choice. Although the version of Day Planner in the repository is a bit old, I've found that it does its job well.
Tip Top Tips: pmiab (Poor Man's Internet Ad Blocker)
- Ad Blocking Without A Browser Extension
Editor's Note: Tip Top Tips is a semi-monthly column in The PCLinuxOS Magazine. Periodically, we will feature -- and possibly even expand upon -- one tip from the PCLinuxOS forum. The magazine will not accept independent tip submissions specifically intended for inclusion in the Tip Top Tips column. Rather, if you have a tip, share it in the PCLinuxOS forum's "Tips & Tricks" section. Your tip just may be selected for publication in The PCLinuxOS Magazine.
This month's tip comes from hakerdefo.
pmiab (Poor Man's Internet Ad Blocker) is a simple bash script that blocks ads and other unwanted nasty stuff and makes surfing the ocean of Internet faster, better and safer experience. There is no need to install any browser extension-addon. And the ad blocking done by pmiab will work across every installed browser.
Save the pmiab script given below somewhere in your $PATH, give it necessary permissions (chmod 755) and run it from your terminal as root or with sudo i.e.
su -c pmiab
or
sudo pmiab
Then you can enable or disable advert blocking via a simple interactive menu of pmiab. To block the ads, select Block Internet Adverts option from the menu. It is advised that you update the ad-blocking hosts file at-least once in a week. To update the ad-blocking hosts, you need to simply select Block Internet Adverts option from the menu again. In case you want to stop ad blocking via pmiab and want to restore your original hosts file, just select Unblock Internet Adverts from the menu. Simple, ain't it.
Feedback-Response-Critique is demanded. Enough rant. Here is the script:
Cheers!
Later on in the thread, ternor asked, "Presumably it is not possible to disable ad-blocking for a particular web site or domain?"
hakerdefo had a reply:
It is definitely possible! But not in the current version of the script! I can add it if demand is there. In the meanwhile it is very easy to manually white-list (Exclude it from being blocked by pmiab) a site while using pmiab. Suppose I want to white-list foobar.com, All i need to do is open terminal and run:
gksu pluma /etc/hosts.allow
And in that file add the following line:
ALL: .foobar.com
Save the file. Voila! pmiab from now on won't block any content from foobar.com.
Forum member orblin came up with a slightly different solution for allowing ads on certain sites, and the solution is included in the script above.
Create a file in the same directory as pmiab.sh, and name it allow.txt.
Put the addresses to be unblocked in allow.txt in the following manner: 0.0.0.0 then a tab then the address to be unblocked.
So in this case the entry would be:
0.0.0.0 app.bronto.com
In the pmiab script, the code is:
Be aware that the allow.txt file must exist in the same directory as pmiab.sh.
orblin went on to make additional enhancements to block malicious sites, trackers and YouTube ads. These do NOT appear in the script above, but you can insert the following lines of code where indicated with the line that appears in red text, #insert additional block filters here.
"I've added Youtube and No-track's malicious sites and tracker block lists to my script. Here is the code, if it's something you might be interested in.
"The code needs to be added before the existing block list download code as it runs sed to add a 0.0.0.0 prefix to the No-track addresses."
PCLinuxOS Puzzled Partitions
Scrappler
Download Puzzle Solutions Here!
Sudoku
Download Puzzle Solutions Here!
Crossword
Download Puzzle Solutions Here!
WordFind
Download Puzzle Solutions Here!
Cryptograms
From the computer of ms_meme:
Everyday I work the daily crosswords and cryptograms in the paper. I like the cryptograms as they are wise/silly sayings of famous people.
The magazine article about secure passwords made me think of the cryptograms. We have people in the forum who are always posting famous/wise/silly sayings.
I have made a few into cryptograms, and hope our readers will enjoy them.
Download Puzzle Solutions Here!
Screenshot Showcase
Posted by tuxlink, April 1, 2018, running KDE
Posted by parnote, April 27, 2018, running Xfce
Posted by OnlyHuman, April 3, 2018, running KDE
Posted by mutse, April 18, 2018, running Trinity
Posted by ms_meme, April 29, 2018, running KDE
Posted by Mr. Crancky Pants - YouCanToo, April 7, 2018, running KDE
Posted by luikki, April 3, 2018, running KDE
Posted by HERTZ, April 7, 2018, running Mate
Posted by golf4fun, April 28, 2018, running MATE
Posted by cstrike77, April 7, 2018, running KDE